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Introduction
Purpose of this Manual

Thank you for purchasing from our Do-more PLC family of products. This manual shows
you how to install, set up, program, troubleshoot and maintain your Do-more PLC. For
installation personnel, this manual contains information on power and signal wiring,
mounting details and configuration procedures.

This manual can be very helpful as a quick reference guide for those who are experienced in
PLCs. For those who may be new to PLCs or our products, reading this manual will give you an
understanding of the variety of features available with the Do-more PLC.

Purpose of this Chapter
This chapter will guide you through the basic set up of a Do-more H2 Series PLC. It contains
step by step instructions on installing the programming software, installing and configuring your
hardware, applying power to the PLC, establishing a communications link, and creating, saving
and writing a project to the CPU. Once these steps are completed, your Do-more PLC will be
running a ladder logic project that you have programmed.

Online Help Files and Other Documentation

Do-more Designer, the Do-more PLC programming software, is available for free download from
our website at:

http://www.automationdirect.com

The software includes searchable online help topics covering all aspects of the software, instruction
set, module set up and communication.

Technical Support
We strive to make our manuals the best in the industry. We rely on your feedback to
let us know if we are reaching our goal. If you cannot find the solution to your particular
application, or, if for any reason you need technical assistance, please call us at:
770-844-4200

Our technical support group will work with you to answer your questions. They are available
Monday through Friday from 9:00 A.M. to 6:00 P.M. Eastern Time. We also encourage you to
visit our web site where you can find technical and non-technical information about our products
and our company.

http://www.automationdirect.com
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Conventions Used

When you see the “note pad” icon in the left-hand margin, the paragraph to its immediate right will be a
special note. Notes represent information that may make your work quicker or more efficient. The word
NOTE: in boldface will mark the beginning of the text.

will be a warning. This information could prevent injury, loss of property, or even death in extreme
cases. Any warning in this manual should be regarded as critical information that should be read in its

: When you see the “exclamation point” icon in the left-hand margin, the paragraph to its immediate right
entirety. The word WARNING in boldface will mark the beginning of the text.

Key Topics for Each Chapter

The beginning of each chapter will list the key topics Getting Started! HAPTER
that can be found in that chapter.

In This Chapter...
12

Purpose of this Manual 1-2
About Getting Started! 1-2
Supplemental Manuals and Other Help 1-2
Technical Support 12

Used 1-3

/\/\/\
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Before You Begin

It is recommended that the following items be available to make this short step-by-step
introduction to the Do-more PLC go smoothly.

Example Do-more PLC

D2-08TA Output Module
D2-03B-1 Base
with 110/220 VAC

F2-08SIM Module
Power Supply = ———p

Do-more! CPU Module

PC Running Do-more! Designer USB-A to USB-B
Windows XP, Vista, Programming Software Programming Cable
Windows 7, Windows 8

You can also use an Ethernet
or Serial (D2-DSCBL) cable
Not available from e for programming, but we
Automationdirect.com. Download software from recommend using a USB cable;
our webste at: http:/www. just plug it in and it works.

automationdirect.com

AC Power Cord

Screwdriver Wire Strippers
TW-SD-VSL-1 DN-WS Hookup Wire
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Do-more! PLC System Components
The Do-more H2 Series CPU modules were designed to stand in place of the DL205 series PLC.
As a result, this CPU easily integrates with D1.205 PLC family components. The following is a
summary of the major parts of a Do-more H2 Series PLC.
CPU
H2-DM1/H2-DM1E

Bases

The Do-more H2 Series CPU module can be placed into any DL205 PLC family base. The four base
sizes available are 3, 4, 6 and 9 slot. All bases include a built-in power supply and can be purchased for
use with AC or DC sources. The Do-more H2 Series PLC supports local and Ethernet remote

1/O configurations only.

‘E NOTE: The Do-more H2 Series PLC does not support local expansion /0.

1/0 Modules

The DL205 PLC family has some of the most powerful I/O modules in the industry. A complete
range of discrete modules which support 24VDC, 110/220 VAC and up to 10A relay outputs
(subject to derating) are offered. The analog modules provide 12 and 16 bit resolution and several
selections of input and output signal ranges (including bipolar). Several specialty modules are also
available.

Do-more! Designer Software System Requirements

The Do-more! Designer Windows-based programming software works with Windows® XP
(Home or Professional, 32-bit), Vista (Home, Basic, Premium, 32 or 64-bit), Windows 7
(Home, Professional, Ultimate, 32 or 64-bit), Windows 8 & 10 (Home, Professional, Enterprise
32 or 64-bit; Windows 8 RT edition is NOT supported).

Please check the following requirements when choosing your PC configuration:
. Minimum PC to PLC Connectivity, at least one of the following:
- USB Port: connects to the CPU with USB-A connector (USB-A to USB-B cable)

- RS-232 Serial Port: connects to the CPU with RJ-12 connector (RJ-12 to DB9 or RJ-12
to USB-B serial converter cable)

- Ethernet Port: connects to the CPU (H2-DMI1E) with RJ-45 10Base-T or 100Base-T
(Cat5 Patch Cable)

*  Hard Disk: 100MB free disk space
e Video Display: 1024x768, 256 colors resolution (1280x720, true color recommended)
. Windows XP, 32-bit:
- 800MHz, single core CPU (2GHz, multi-core or hyper-threaded recommended)
- 512MB RAM (2GB recommended)
e Vista, Windows 7 or Windows 8 & 10, 32 or 64-bit:
- 1GHz, single core CPU (2GHz, multi-core recommended)
- 1GB RAM (3GB recommended)

— | NOTE: The PC/Laptop/Ethernet Switch connector at the “opposite end” of the PLC connector will dictate
— what kind of cable you need.
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Step 1: Install Do-more Designer Software
Download the Do-more Designer programming software (DM-PGMSW) from our website

at http://automationdirect.com and launch the install procedure.

-

Dio-more Designer - InstaliShield Wizard

Welcnme ta the IngtallShield Wizard for Do-more
Designer

The InstallShield Wizatd will install Do-mone Diesignen on
waour computer. | o confinue, chek Mest.

[

The first screen that opens is the Welcome
screen seen here. If there are previous versions of
this software already installed, this screen will
detail the version number of the software being
replaced and the one being installed, click Next
to continue.

Do-more Designer - InstaliShield Wizard

===

An alert window will appear requesting

b the |
Detigner

continue, click Mext

¢ Back Mot »

‘Wwizand fnr I

The InstallShisld Wizard wil update the installed version
US| of Lro-more Drasigner bo versaon UUEYTY. (o

that all anti-virus software be disabled

and also reminding the wuser that
Administrative restrictions may exist.
rfkl-mnn- Designer - InstallShield Wizard m1

< . Belure continuing with this Selup program,
' please be sure to disable any anti-virus software,
~ and insurc that you have Administrater privileges.

The License Agreement window
will be displayed next. Read over
the agreement, select “I accept the
terms of the license agreement” and
click the Next button to continue.

There is also the option to print the

license agreement if desired. The
print function will print the license
agreement to a pdf file and save it
in the location you choose.

1-6

r B
Dro-more Designer - InstaliShield Wizard M
License Agreement
Flease mead the fullowing oeree agreenent cacluly,
Do more Devignee Licanza Agreement i
IMPONTANT o
REFORF OPFMING THIS PACKAGE AND LISING THIS SOFTWARF YT SHOLILD
CAREFULLY READ THIS AGREEMENT
The enclosed computer softwane pragram [the "Soflware] i the propeaty
of Automationdiect com, inc. o ks supplers. Defore installng thes package, carcfully
il thiz Agrermmenl. 1 vou g nol accepl e e sod conditions of this Soeenmen
ity shradd tetum the ercineed Snftware and ang accompanging items: inchidng any
manuals, relesse nobes, binders, ete. ], unopened, to Automationdirect.com for a full -
@ | Arcept the: tame of the liceroes Agresment Print
I do mot accept the beims of the Beense agreement
Bk [ Mewr | [ Comed |
4
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|
rDa-more Designer - InstaliShield Wizard M‘
Now the software will ask a little Customer Information
. Pioese enter yous ifosnalion.
about you. Please fill in the i i
information requeSted on the Please enter your name and the name of the company for which you werk.
Customer Information screen and
click Next to continue. User Name:
AT
Comparry Mame:
At this stage, the software will ask
which type of install you would like
to perform. The Select Type
window seen below gives two ld :
options for installation type: <Back Mot
Complete and Custom. s J
rDo—more Designer - InstallShield Wizard M1
Siatus Tooe: ' Custom installation allows you to choose which

Seectthosaiig lypa o ok program features to install, whereas Complete

installation installs all of the program features
available. The Complete installation is selected

@ Complets by default and is recommended for first-time
@ All progs am fealures will be instaled. [Reguies e most disk spece. ) users

Mease select & sehup bupe.

) Select the installation type desired and click the
Cuszhom .
. Next button to continue.

Selecl which pogram leslues you want installed. Recommersded v
artvanced Lsers

¢<Back [ Mows | [ Camed

L 4

f v
The next screen to appear is the | Bemere besigner- instsinild Wizard i
Ready to Install the Program Hondy toInatell the Fromam':
. . . . Thee wicand is ieauy W Legr islallgtion,
window. This window is an alert
window, cautioning you that the Chick Instal to bein the intalation.
program is about to be installed. If I s wranl 1o v on cherage arw of yous isialletion sellings. chuk Back. Click Cancel o ex

thie wizand

there are any changes that need to
be made to the install settings do
them now before continuing.

To review or change any of the
previous installation selections, click
the Back button to return to the
appropriate window and make the
change. If no changes are necessary
click the Install button to begin the
installation.

cBock || nstoll | [ Coneel
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Ma-mare Designer - InctallShield Wizard

]

9u Do you want a Do-mare Designer shorteut on your DeskTop?

to conti

es

No |

r
[Do-maore Designer - InstaliShield Wizard

Setup Status
The InstalShiedd Wizard is instaling Do-mare Designer

Installimg Program Files:
C:ADg-mote Desighen Bin'\PrgE wtlim. dil

The popup shown here will allow you to choose
whether or not to install a shortcut for the
software on your PC’s desktop. Click Yes or No

nue with the installation.

The software will now install the
needed files and folders with the Setup
Status window detailing the status of
the installation.

Once the installation has been
successfully completed, the window
below will open. Your software is now
installed and ready to use. The
installation wizard can now be closed
by clicking the Finish button at the
bottom of the window.

r
Do-more Designer - InstaliShield Wizard

InstallShicld Wizard Complcte

The lnet,
Diezigne

T es.

Yes,

alShirdd Wizard haz surrrzsfuly nctalled Do-mnre
r. Chick Finith to exil the wizard.

| weard b e Lhe Riead Me ke,

| wark o launch Dermore Desianer now.
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Step 2: Launch Do-more! Designer Software

HHZ After installing Do-more! Designer, launch the software by double clicking the
| desktop DM icon.

You can also launch the software from the PC’s Start [mp _
menu or All Programs menu. If the software link is @ B mpie Hesigner

not embedded in the Start menu, use - _
the path: Start > All Programs > Do- De-more Ul i
more > Designer x.x > Do-more Designer1.2 L A
Designer x.x to launch the software. (&' Do-more Designer 1.2 Help
& Do-more Designer 1.2 Read Me
;!g Do-more Designer1.2
The Do-more! Designer Software will £ Do-more Forum
start up and display the Start Page E2d Do-more Logger1.2
shown below. This page consists N Ho-mase Simuksar 1,2
of a Launchpad with quick links to » U”mt_a”DD'mmEDES'gnerl'z
existing projects, software applications Ra-moxe Dedoae! -1
and communications links. There | 4 Back
is also a section containing shortcuts
to important help file topics and | Search programs and files 2|
the Do-more! Designer simulator
application.
55 5 mer g - 5t el =
[ Fie View tiep T
* s y 2
| :‘:I'"" Hl-'w ‘J:: llllll [||||||r'..\‘rE ‘1":!

PEE Pasws

Clikan ary toplelaubtople 1o Janm mars Ehasnge-Stwrt Peige Contarit In Glabal Options
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To begin a new project offline select
New from the toolbar on the Start
Page. The New Project window seen

Mew Project

i

— Mew Project Mame

. oK
here will open. |My_DM ml - I
Name the new project and select the _ Sz |
type of controller itis intended for. You Fm"y : e Tg :le:sm

Jo-more (L] Lontroliers -
can use the Browse button to choose a H2-DM1 Help |

different location to store the project or
use the default location. Click OK after
your selections have been made to
continue. The Main programming
window and Instruction Palette shown
below will open.

The Instruction Palette lists all of the

. . ~l bl f . Snstructon Pulevet
instructions available for use in your -
program. A brief explanation of Conacroats —{—
. . . A Conct-Diferenaal — 1 b= —d ['F—
each instruction is provided once the e o = e T
instruction is highlighted and a more Siws (00) U om g )
detailed explanation is available in the = oo T T g
help fil Commricaton CHECKSM DU DUAY  [MOCAP FMAL  GSREGAD : o
( p c. MAYL OPENTCR B 3 T PING  SETUPIP  SETLENCD
SFTUPSER  STREAMIN STREAMOUT TOPLISTEN
The Main programming window is Conetin FEGONT MEIGWR @AY SOAD SG ST STRAMEA  SwAR
p g g CTRIO Gmrﬁ C‘::mn“w 'IRsm‘ Tinc CTANLIMT  CTAXTRAP CTOYNPOS CTOTNVEL
divided into menus and toolbars for RSO CREDT ChmD CrEom CRADS CRAWL CTRAD CTROR
quick access to configurations, || "R TR i sl EER SRR T T
instructions and other needed items S ’".:.:,: e e . wme e
. . nopEy EONTILE s
used during project development. B = B e e e e
PIDINIT  RAMPSONE  SLOPE T
Program Contral  ENTASK Bar GOTO HALT LADL RABOOT RISTART e
STOP SUSPIND  WATCHDOG  YIELD
Query Information. DATAING -~ HWINEG
RO 8 Laltee T BER SR
3 Do e Deigre - Uy DM - ESbdar] |=_:__m__ﬂ;ﬂm
|1"— @ 2D % o p von o) B > @
Opem Hew  Bachp Aeept Unde L Brewie Opter CnTheWeb  Tp L
han 009 S . e
.H(mh‘cﬂhhluhﬂcﬂﬂﬂgwm%
| B e Bl s o 6 S B
eleinls] = |
;_.4{,:..«.....,,, 1 ' J IS5 we 3 i:l
J ;-,_af'.”:’.',';:im....(
F { me )
Ladder
3 L) noe
&3 Ten
gsf—rwm— r f { me ]
[
5 { noe )
Projmct
Browser & { we )
4 Ladder { we )
T Palette ]
8 x nee )
) | N £ -
[ @ @1t 4r 4k Uk = s ist bE 2O O RL e E
| Titrections  Accept "’ a3 SheFl  Shef3 = 03 ' Defty Oat St ket Browse W B
irfff-n_:_v_q_xla . S——. PIC Mode bt DrbagModindes 5 P D Ofiae  meisssn Ho-cend

Do-more H2 Series PLC Hardware User Manual, 1st Edition, Rev. J - H2-DM-M

1-10 |


http://www.automationdirect.com/pn/H2-DM-M

Chapter 1: Getting Started

Step 3: Install Hardware

The “Installation and Wiring” chapter of this manual contains detailed information for the
installation of components in your Do-more! PLC system. The following summary explains
the basic steps for installing modules in a base.

First slide the module retaining clips to the out position and align the PC board(s) of the
module with the grooves on the top and bottom of the base. Push the module straight into the
base until it is firmly seated in the backplane connector. Once the module is inserted into the
base, push in the retaining clips to firmly secure the module to the base.

Push the retaining clips in to
secure the module to the base

Align module PC board to slots

CPU must be positioned in the in base and slide in

first slot of the base

WARNING: Minimize the risk of electrical shock, personal injury, or equipment damage. Always
disconnect the system power before installing or removing any system component.

Once all of the modules have been
installed in the base, connect the USB
cable. Use a standard USB cable with
Type A and Type B connectors.
(Ethernet and Serial connections are
also available, but are not shown for
this example.)
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Step 4: Apply Power to the Do-more! PLC

Power is supplied to the Do-more! PLC through the backplane of the base from the power
supply. The following diagrams show the terminal connections located on the power supplies
of the DL205 bases. The base terminals can accept up to 16AWG. You may be able to use
larger wiring depending on the type of wire used, but 16AWG is the recommended size. Do not
over-tighten the connector screws; the recommended torque value is 7.81 Ib-in (0.882 N-m).

110/220 VAC Base T erminal Strip

EE CiEE

1

100 — 240 VAC
—

—D G
— 45 LG

_I +
24 VDC OUT, 0.3A
—

‘E NOTE: You can connect either a 115VAC or 220VAC supply to the AC terminals.

12/24 VDC Base T erminal Strip

—
10.2 -28.8 VDC
— 1 -

—D G

DVDD|D|®

125 VDC Base T erminal Strip

D|D|D|®|D|®

—
120 — 240 VDC
_
—D G

— 4 LG
— +

24 VDC OUT, 0.3A
— ] =

Once all of the power wiring has been completed and verified, connect the appropriate
voltage source to the power supply and power up the controller. The Do-more PLC will
perform a self evaluation once power is applied. Refer to the “Installation and Wiring”
chapter of this manual for more power supply and input wiring information.
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Step 5: Establish Communication
Now that the Do-more PLC is powered up,

you need to establish a communications link

between the PC and the PLC. The Do-more! Designer software provides a Link Wizard to
assist you with configuring this new communications link. To open the Link Wizard, select
the New Link... button in the Links section of the Main Page’s Launchpad as shown below.

[ i
- - "
= - s - P e i
Optiom  On The et Tip
Xy & off
Configure Diedoss  Check .
| v w
| ! Il { nor ) 3
2 { nor )
oo || e[ e | [ Fors
Appicxore: % { wor )
e B s v 2 e
e TR S ,
it ot B [ T— 4 { noe )
Mot Forum, FAQn, Dowrivadn... L Megst 3
TR0 198 7 Domore LT . o
&l = " ] { noe )
[
4 { noe )
F { we )
o { wor )
[l { wor )
=l
=} dzt d sk o 2L A () B B P W ﬂ '
= 1 « . Dets D Sa Red  Bese | tw .
S P D Offine | COOMNYISHN 4O-DMDE

&5 The Link Wizard will first ask you to

Sedeck e communicabons port Hiat the FLE 13 conneched ba.

Modern suppodt cannat ba confiqueed from tha Link Wizard,
To select modsm suppor, pou must uss the
corfiguiation dislog by selecting "Link Editor,..” belove,

Ptz

LUMT
Ethcinet
Modem

choose which communications port you
will be using. In this example, we will be
using a USB connection. Select USB,
click Next and the wizard will
automatically search for available CPU’s
on that port.

Choose the CPU that you are
programming and select Next. The Do-
more Designer software will create a link to
that controller.

The Link Wizard will now display the

saved settings for this link as seen on

Link Wizard [
= Select an altached device from the list below.
. v 3 _
Lirk. F b Rerk | Nesd > I Car Prervs "Rlefiech Lit" o update e it wilh e devices,
1~ Curmently Artached CPUs —

| Refiesnin

IMMOATANT HOTE: LIGE desices that see slvead in uae i another nk sl ot shove up in this.
Bzt It wou need bo refescnce a smgle dewvice i rare Bhan one link_ make sure that device s not
curently in uss when Tunning this wizard

Lirdk F (lion

¢Rak | MNeay | Canwdl

L

following page.

4
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[ |
A unique name is required for each link that is
Lk sefings compleled created. Name the new link and, if desired, give it a
Plesss selact 3 uritus name o1 the e firk, description then select Finish.
e 7 E— You can also manually configure each link by selecting
Lk Oeesplbrs | the Link Editor... button from the lower left corner
e | of the Link Wizard. The Configure Link dialog will
PLET H2DMI Pt [ 1R open, as seen below, allowing you to select PLC types,
Proocst G mors (OWFLCA  Baud | port parameters, and protocols.
Address: 1 Panky:
Conbgure Link =
Lirk F chlon L T v e
§ . : PLE | Pon | Protocal |
Once you have completed configuring || picpum BLCTine
your communications link, either ELTTEe [
manually with the Link Editor or | |*

automatically with the Link Wizard, it will
be available to select in the Links section of
the Launchpad. There you can edit, enable/
disable, delete or view statistics for that link.

f f
| Aecepl | Cancel Help Auitey Bk
> 2 =
Fie Gdt Search Yiew Tookh FC Debug Window Helg o
CoEO? 2% %5088 8% & g
Open Mew  Rackop Unda Find [ Optsors. | O The Wb
& & i ™ @ % P H W oy & e
Mew Dtling Qp-moss’Sm | Dita Goaligurs Davices  Chack
Jmncrgad Mz e Foge (@ Shkain|
Link Info
t Ji Lirk Iedcenabion Lick Pedcimarecn
Maoe: DM _1 Ti v ]
B Dierscriphir Corrgbted T ("] Hely |
Statur ficive Pos Court: ] EdiLink
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i

Select the New Online button and the Online dialog box, seen below, will open. From this
dialog, you are given available communications links to choose from with options to add, edit
disable/enable, or delete links.

i ea| Choose the appropriate link, select OK

Online
and the software will connect to the Do-

(el .
lMewDMT'EC . more PLC. If the mode selector switch on
| I, . . ..

el the CPU module is not in the Term position
3 . .
~Lirk when connecting, the warning shown below

bySim : on Local Port Add..
i Edit...
Dl |

will appear.

Waming! '___"-" g

PLC is not in terminal mode! Some comm
operations require terminal mode. You may
¥ Link Enabled continue, but may receive comm errors.

8 L
You are allowed to continue if you wish or place the
mode selector switch on the CPU module in the

Term position to avoid any unintended
communication errors.

If you were connecting to the CPU module with a project created offline, you may encounter
the message window shown here.

- \
Resolve Online/Offline Differences £

ATTENTION! There are differences hetwesn the affine peaject and the PLC yao are rannecting ol

—Netai
System Configuration: DITTCRCHT

- System Configuratinn indudes the ronfiguration for Memney, (PLL T/0, Modules, T/0
Mappings, and Devices.

Program: MATCHES Compare Programe...
- Program indudes all Controd Logic, Code-Block Configurations, and Execution Order.

Documentation: DIFFERENT
- Documentation indudes Clement Documentation, Rung Comments, and Project Information.

Please select one of the followina:
1

The currently loadad disk project will remain in memory. If the PLC is a differant
(50 Unline and wiew the DISK project Ly Uaan e wanrenl project, Ue project will be mudified il ieeded o match
the PLC, and any required changes will be directed to the output window.

The PLC's praject wil loaded into memory, and any offiine project data currently
150 Unine and view the FLL project | unsaved wil be discarded.

Cancel, and return to Offline Return to the offiine project without connecting to the PLC.
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Only with the New Online option does the Do-more PLC assume that you are creating a new
project from scratch. With any other method, such as PLC > Connect, the software will compare
the project in the controller with the offline version you have open. If there are any differences,
this warning window will appear detailing the options available for continuing:

1. Go Online and view the DISK project - This option
will go online with the PLC but display the project
from disk. Status displays may show incorrect
information. If the memory configuration in the disk-
based project contains elements that are incompatible
with the memory configuration currently in the
Do-more PLC the message box seen here will be

displayed.

2. Go Online and view the PLC project — The project from the PLC will be opened by Do-more!

Designer.

Online/Offline Incompatibility

L

PLCASC NOTL!

ous e cheren Lo gos o, bl s ] the offlee program
that containg an incompatible memory configuration,

This s velhd, bt pleases bes aware thial prior 1o downdoading the

offiine program to the PLC, stabus deplaye ma y incorrect
nfonmation, T e fed st yous ety oo
the offiine program to the PLC.

Contirmse Ordire i

Retuw T O Thine |

]|

3. Cancel, and return to Offline — This option will cancel the connection attempt and return to the

offline project.

. Compare Programs... — If you are unsure as to why the two projects are different, then this option

will do a comparison of the projects and detail the differences found. An example comparison is

seen below.

-
# ° Compare Programs [My_DM to Project in PLC]

=)

¥ Show code-blocks only in My_DM
% Show code-blodks only in Projectin PLC
Exec® My DM Code Block
1 $Main 1 5Main

2 MyNewProgram

Instruction Differences
$Main My DM My_DM Mnemonic
<top of code-bluck=
$Main@0  STRN CO
|SMain@1  OUT VO

| ]

" Show Differences Only

[¥ Show Code-Dlocks in different execution order
[# Show Code-Blocks in consistent execution crder

Exec® | PLC Code Block

Key: Different Only in Cument Project Only in Other Project  Identical

& Show Differences wfContext

Carpare... ]

Close

Disk Addr... |Disk Mnemonic

<lop of code-block=
SMain@0  STRCO
SMain@1  OUT YD

€ Show All Logic
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According to the report, the PLC project was different in two areas. First, a new code-block was found
only in the PLC project. This new code-block is titled MyNewProgram and is highlighted in green.
The green color represents items that exist only in the Current Project (project in PLC) and not in the
Other (project in PC). Also, the comparison noted that a normally open contact (STR) was changed to
a normally closed contact (STRN) at $Main@0. This item is highlighted in blue which represents items
that are different between the PLC Project and the project in the PC.

Other colors used in the comparison are red, which notes items that exist only in the project on the
PC and not in the PLC and black which highlights items that are identical in both projects. There are
also numerous checkbox and radio button options available to help you analyze the differences between
projects.

Once you have connected to the CPU either by using the New Online option or using PLC
> Connect for offline projects, you may encounter the initialization windows shown below.

e e W The Set PLC Clock option allows you to

Armew Doamore conleoller, on Do-more conbiober et has been cleared, needs Lo have is li.emd set the lnternal’ real-tlme ClOCk 0{: the PLC'
ealdine clock s=t, Clck the Set PLT Clock bullon Lo sel the Curent Time, the Time Ze——

the Dyt Savergs Acpusirmend option, Set PLC Clock =)
| Cloxtk Settings
& Sel o PC's current lime settngs..

FLC Clodk Mobes:
De-mare CPUSs store time intemally in UTC, but adjust

T for local tmes 115ng A fimesone adiitment specified in
4/09/2012 15:24:56 e
UTC -5:00 (-300 mirmtes)
Sl PLC Clack - Do-more CPUs admst local tme for Davlight Sanvange
Daylight Savings Time : ON Time, bu thes is only done manually, to aveid confice
with widely wrying baws.

 set o manusl settngs... Tene e can e st o by g the
Remember t

[~ Diont show this agein | - m ;;:hnvadt!l’mn.—:m mber b
For example: US Eastern Standard i UTC - 300
minutes, 5o STimeZane wolld be -300.

Doyight Savings Tine can be adsted of untine
The Set PLC Clock window has e . mwfn.mtmmmwrﬁm'
options for Timezones and Daylight e
Savings Adjustments.

[ Setpic o adEnt | Cancel

The Setup System Conﬁguration @

option allows you to configure the

parameters of the Do-more PLC. 1/O Ko Diwnirs bordrien,ox 8 Devasre onlioler s iss beery elsiria ciealis b el

| sl configuetion when 1L is powened up bor this e fane. Chck U 5ol Systaos Coriflguralion
module configuration, CPU ports, || bstente dpiy e et st confgastin dte s cponsly e e ooy
and I/O mapping profiles are a few ool e CoA e eboslods &gl

i
= carifiggues e Miockdes Bl rrsp it scoiesal sl idourntion

* cortfigeine the Tevices that pllow sccess b the CPLs ports and b sy speciaky 1) Modudes
* change the: defu it 10 Mapping

of the parameters available in the
System Configuration window. Refer

to the following section for Hardware i Sy st |

Configuration options.

I Do) shom this again < Rark | Frish | Conced
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Once all parameters have been configured, the following programming window will open with
the online toolbar active.

¥ Domore Desigrer - My DM - [$Man] - = —— Lo ) i
File [dt Search View Teok PLC Debug Windaw Help
i £2 B f 7 g 7 £ b f L = e *
® W ¥ e & = B R ;'\' e A ) |oox-] B @ &’
Open  Sove  MNew Backup | EdtMode Unde Find Beowie Ogtions | OnTheWes  Tip &
R X G 4 ey i T Eeerd 1 v X ﬁ = ©&
W g @ T 5 v w H Wy o = P
Hew Orline Do-more/Sim Statis  AllStatus MoStstus | ForcesWg Vale | Mode  Info  Configure Devices Check  PID Overview PID View .
Pragiet Drowdel \ T
rlafiz]s] salds ——I \ ﬂ
3=} Control Logic ' { noe )
e Bl $Main e
BR svstem Tasks Online
@ B8 Uenised Systom Tasis 2 Toolbar nee )
Tasks
B Progems
& B¥ Configurition -
[ Meenary ? { woe )
¥ Foroes (Dicabled)
= cru
e Devices ¢ { nor )
[# i Unassigned Nicknames
B 4 Tock
XY System Configuratsen s M
& Syvten info { o)
B, Pavwenid Cortyg [Delauli Lser - B WD 8P WP S5 P
3 { nor )
Status Bar 7 { noe )
B i , =
0§ “ [

For Help, press FL

a

Notice the status bar indications which show PLC type, memory usage, communication
status, PLC errors, PLC mode, etc. Hovering your mouse over the status bar will highlight
the items that are selectable. If you select one of these items, a new window will open with
real-time data and options that are available for that selection.

As an example, the System Information window seen here appears after selecting the Memory
Usage indication from the status bar.

-
System Information

Geoweal ifomation | System Status | Evert Logs |

Tyt Merrary Lsage I~ Verson
PLC Type: | HZDM1 M Program: B553 Domars: | 011.0
Serial Number: | 00 00 1300 00 4D Program Used: T 0S: | paze- i
Mode Max Documentation. | 104RETE Bocter. | 306
Kepswdtch. [ TEAM Documentation Used | 540 FRGA [ st
PLC Moda- | Rum Hardware:
L System Clock
5‘“::“"’ — i uﬁ;ninu@'i:" .I'lr-m:_'lg:-bb'.li il M‘
[ T Teme Zorw: UTC +0H00  DST: OFF
[ | Mac [ 2Eme et o
- Node s IP Cordiguration
[ Modie I [0 1P Addes [ 152168343
I HNama: DM_1 Subnet Magk: | 255355255255
Desceotion. Boman Gatowar: 0600
l
Set Node and IP Confuration |
l
I oK b |
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Step 6: Verify Hardware Configuration

Next, you will need to verify the hardware configuration for accuracy. The Do-more PLC
has an auto discover feature that will automatically detect the I/O modules installed in the
base. You can see the results of this search by selecting PLC > System Configuration, double
clicking the CPU link under the Configuration tab in the Project Browser, or by clicking the XY
Configure icon in the Project Toolbar.

3> Do-moee Designer - Wy DM - [SMsind |E|Eﬂﬂ:)n
| Fe E&t Sewch View Took [PLC | Debug Window Help ‘he
& o\ £F Tl = . i o "
RZAR N . “ e BB L FTw E @ D |eft
Open Sae Hew hhq:! Reiopen Semions: Faned Brewse Options  OnTheWed  Tip £ ide
- - - » ; LE il ;
i dh A s c EE R oww Y w e = P
Mew Online | 5 ind | Stabur  AllSeatus MoSstus  Foeces  Value | Mode  Info  Configue Devices Check | PID Ovendew PIDView . || ) f
Frnject rawse & DeviceList... o| 1o x|l
| ¢ a2 aalas |l Frogesn Chedk.. / % 'he
[E) Comtroiloge | B PlEModes.  Cul-Shift-R I { ]
¥

{ uor
[ R TTPN System Information... —
B
- B Urused System Tasis | g Mismcey G 5 (

\'I noe )
BB Programs = SePLC Clock. b
W Configumtion F Password., \\ :
— |

#  Leunch Do-more imulatce

i
-0 Memary S Clear PLC Memory.. \ / i HOP
'
S

T Forces Dissbled)
Z { noe )

-2 Uruassigned Nick
i icknames o

B2 Tooks

K Symem Configuation Configuration { wee )
L & systemInfo >

B Password Config (Default Uses - D WD RP WP 55 P

5 { e )
[ = v =
! 14 | 4IF A1F | 4=F 4= 4=t i<k =F 4=} | 1A - R} ;5 4 i
Browse Edit Mode
Configgure the project’s PLC Systemn, U0, Memaory, Modules, Devices.. | Fum 1w sio | 050 080 000 Devs 0K PLCOK | OnbineDefauis Ureo D) [JESRINY 0006365536  Ha-0ia
System  Configuration  window is an  index of  topics  titled

Configuration Entries. Click the I/O Configuration tab and you should see an overview of
the modules that the software located, similar to the following.

Systemn Confquration

Configuration Entries 10 Conffigura tion Crverview
CPU Configuration
&
[ DL205 Local [0 Master
DL 205 Bace
Madhile Coniguration(s)

From here you can verify that the software has detected all of the I/O modules that are installed.
At this point, you should also verify the base size. The Do-more PLC cannot automatically
detect the base size and if it needs to be corrected, select the DL205 Base tab in the index and
choose the appropriate size from the drop down list on that page.
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The Do-more PLC allows the I/O to be manually configured as well. In order to do so, you
must first set the I/O Configuration Mode to manual. Select the DL205 Local I/O Master tab
found under the I/0O Configuration tab in the Configuration Entries index.

—= =) The 205 Local 1/O Master

Configuration window shown

Syatem Configuration

ik e here will appear. From here
O Conliprebio 1/0 Configuration Mode
bl 110 Lanfauraton = select Manual to configure the
= In "Autn”, the FLC automatically oreates the <
Ty prE eyt e e e (S I/0 modules that are installed
- Mehdes Comfigpuation(x) . . .
Devee Canfirain T e ou st roide e in the system yourself. It is
18 Mappings P ation, which the PLE well comgaare o .
l : the nstaled /0. The manusl confguras important to remember that
Mtngry Configurabion and instalied 1/0 must match before the CPU .
| il 0o to HUN mode, the PLC will compare what you
. LS | configure with what is installed
i and they must match for the
y
I ' | PLC to work properly.
& ] — .

NOTE: If the manually configured I/0 modules do not match the installed I/O modules, the PLC will not go
into Run Mode.

After you have set the configuration mode to Manual, select the DL205 Base tab in the
Configuration Entries index. This will take you to the following set up window.

: _— - _ -
SyMlem Configuration e e e S s e e --—- e
Configuration Entnes 205 L0 Base
[ G ConBquration f
5 1 Configurason _l
F-EL205 Lucal 170 Mastes
Modie Configurasons)
Device Cortfguration
10 Mappings Add Medule 3 Discrete Ingut 17 0?0803
] Aoty Qondoumaon Discréts Output ' D2-08MA-1
[ Discrete Combo - D2-DEMA-2
[ F2OBSIM
| #inalog Input 3
i &naleg Cutpurt v [2-16M03-2
[ Analeg Comba [ D2-16MA
Specisity v 02-32MND3
[ - P
Marusl Base Soan Dase Sxe —_—
[ D2-32MD3-2
Wi L 10 Master s vt b Marual™ [0 The DL20S system cannot sutcmaticaly
1 corfigurason mede, Lt "Sean Base” to read detrct base sz, Seiect the base sz
the curment base contents nto the manusl
erligr atun. |
Sean Base BmseSle [F50E ¥
{
{

oK I tmn-ll el |

Notice that from this window, you can perform a Manual Base Scan. When initiated, this scan
will poll the available modules in the base connected to the PC and display the I/O found. The
results can then be altered as you choose. This window also contains the Base Size selection
which is used to select the base size that the system is using.

To manually enter your I/O modules into the configuration, right click on the slot the module
will reside in, select Add Module and then choose the module from the drop down list.
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Once you have selected the module, it will appear in the slot that was chosen.
e e . TR

Configuraton Entnes | M5 L0 Base

CPU Configrr stion
B 1 Configuration
£ 0L205 Lacal 10 Master

Mew Module
Added

: Marnal Base Soan - Base Sze 7 M
\When ghe 00 Master is set i "Manual” [0 The 0L 205 system cannat automatically
| cenfiguration mode, e "Sean Base” to read detrct hase siee. Srlect the hase s
the arent base contents ntd the manual belaw.
configuration. P
Stan Base: Base S [TECTHNN
!
'
o | Cancel | el |

If an I/O module is manually configured but is not available for install or if at any time it has
been removed for maintenance, the I/O configuration will allow you to place that module in
an Optional state. This will allow the PLC to function properly without any hardware
mismatch errors. As previously mentioned, the Do-more PLC will not enter Run mode if the
configuration does not match the actual modules installed. With the Optional state, these errors
can be avoided.

,;,._.,cann-gmm — - ‘ﬁ'_ —— N — — — _‘- i’

Configuraton Entries | 20510 base
CPU Configuration
5 10 Configuration
[ DL20S Local /0 Master
DLZDS Dase
Module Configuration(s)

Optional =

Delete Module i

! ~Marrual Blase Scan 1 1~ Bege Sire 1 i

i
i When the IT) Master 5 524 to Maruial” 10 The L2105 system cannat autamatically
configuration mode, Lise “ican Base” to read detrctbase s, SEct the base st
he aument base contents inta the manual L
configuration, !
Scan Bose Besesze (I T
I
o« | e | Heo |

I

.. =

To make a module Optional, right click on the module and select Optional from the drop down
list. The module will be labeled with the word “Optional” and the PLC will ignore it when
performing the configuration comparison.
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After the hardware configuration has been verified select the I/O Mappings tab in the

Configuration Entries index. This option will display the assigned addresses for the configured
modules as seen below.

System Configuration % ' [
Configuratan Eniries O Map
€L Canfiguraton Slot Mod ID Shot 10 X Map ¥ Map WX Map WY Map
F+ 1/ Configuration
léonzos Locsl 10 Master 2 DLIS Loeal 1O Master
i “1'*'"’;“’:“ i -] DLI0S Base
cefigurahonts
Devier Configuration L A X L
I
Memary Configuration 2 Fa v
I
f
I
Mg Made ManLind Mode Tnstnctions
In "Auts” made, the PLC automabiesly sssions Automatically sesicried addrasses sre Map vslues that eceed memary snfig sre |
image regster add-esses to each skt shown i grey. shown in bokd red.
Elestesmmon i || ssb— oy ruimnein |||
Map range overlios are emars, and are |
= Aut ¢ Manud M show in red.
.3 I Caneel el

These X, Y, WX and WY addresses are automatically assigned by Do-more Designer. You

have the option to manually configure these addresses by selecting Manual in the Mapping
Mode section at the bottom of the window.

The Manual Mode Instructions section, also found at the bottom of the window, details the
various color indications associated with this mode.
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Step 7: Create a Ladder Logic Program

To create a ladder logic program, you must first place the software in the Edit Mode. Click
the Edit Mode button found in the Project Toolbar or Ladder Palette Bar or use the shortcut

Crrl+E.
e - isiniy )
File £t Sesech View Took PLC Debug Window Melp -8 x
2 1l iE % & BB (= / = il
v W\iE @ m:m..,ﬂ‘@mr 6 PN O . E @
Open  Swe  New Backup | [ETRUIEL thaa Find Evowse Options | OnTheWeb  Tip
-} 2T - -3 - = =)
; 1 @ % T % el O oy ek = P
Mew Online Domere/Sm | D Déwg Tremd Stoer Al NoSius | Forces  Vekoe | Mede o Configore Dovces  Check | PID Overview PID Vicw «
Preipiet Browedr x| M 1
vl 18] I
5] § moe

=T Commatboge | 1 - { b] j
= 80 sen [—=
B Symem Tasks SAEE
= B Unused System Taks
T Tosks { noe )
BB Proguens
-8 Configuration
< Memaey 3 ]

¥ Fosces (Disabled) Edit Mode
Fs )

= i Dowces 4
1B Ll Unsssigned Backeame:
B35 Tooks Active Ladder l
fﬁ: Sytem Canfiqueation Palette Bar { wor )
System Infe
B2, Dasowerd Config [Dafsult Ugar - D WD AP WD 55 \
W . ¢ =

uno Y

P VAL N e e MO8 P Ea © |

-
z
3
o

§

Imtructions Shefl  Shefd Heset Beowse
Start ot stop eddiing of project's control- bq.c Run e sun | 550 090 000 DesOK | PLCOK nmwngmu;um-u-mmm H2-OML

When in Edit Mode, all of the Ladder Palette Bar’s options will become active and the cursor
in Ladder View will fill in blue. Now, you are ready to begin entering the example ladder logic

below.
Rung #1 _ - ~m¥|
Place the box cursor in the NOP position on Rung #1. '} - :. 0% - | =

If the Instruction Palette is not open, then i FPRot 1 T o
click Instructions from the Ladder Palette *@ Xy &9 ‘ =

Bar and select the TMR (Timer) or type Instructions ol = Comigies"evces ek Pl 1) Oveniny
a “T” and select TMR from the drop down menu, then

press Enter. Once TMR is selected, a Timer dialog box
appears. [I=]=]2] R
1. Set the Timer Struct to T1. TMR Timer | DeTRor
2. Enter 03 into the Preset Timer Struct  [T1 5
Constant Value for the Preset
seconds (s) preset. & Constant
Drop D
3. Click the checkmark in the [ 0oh 00m 03s 000ms” / mw?enzwn
upper left corner to accept. " Variable o
After clicking the checkmark, (Do | ms 0 i )
Rung #1 should show the T1
timer (TMR) instruction with b o B

a preset of 3.000 seconds. A user variable can be assigned SL IR D | a6 | '
CRArAEd © |

to the preset value if needed.

Browse Bl

1 _nnm%rﬁaﬁﬁ H2-D
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Since a Timer is a structure it has predefined elements associated with it. Elements such as
Acc (accumulated time), .Done (the completion bit) and .Timing (the timer is enabled and
timing). Therefore, if “T1.” is entered into any contact name the Auto-Complete feature of
Do-more Designer will display all applicable bit (boolean) selections available for that structure.
Selecting the T1.Done option as seen below, will assign this element to the contact and the
contact name will be T1.Done.

M E L
Pl T1 Done { nor )
T1.Reset
/
3 i { nor )

This feature works for all structures including: timers, counters, PID loops and strings. Many
system data types such as, $Main and $FirstScan, as well as user-created devices like ECOM,
CTRIO, or SERIO modules can also use this feature. See the Do-more Designer Help file for

more information on structures.

[(Create Nicknacne =)
Now place the box cursor in the leftmost
column of Rung #1. Type in a meaningful Ncknams: |T1. 5t o |
nickname, such as “T1_Start”, and press || AostedEment | Cancl
Enter or select the Normally Open Contact ||  Creste ricknams and..
(F2) from the Ladder Palette Bar, enter e e o ety o e nt o e |
“T1_Start” for the name and click the =]
checkmark in the upper left corner. Either |
method will open the Create Nickname " _.assignto symbokc constant
dialog seen here. Select the third option to || e [ T I
assign the nickname to a specified element, e
type the desired memory bit for this S
contact (C1) and select OK. S ¢ E
.. Jeave unassigned |
Type. [Bit, Y, C, elc) Ea
L 4
Rung #1 should now appear as follows:
o iw“' 10 x
| 11 stan THR Timer j
=t
f——v i Timer Struct T
Hresel 3.000s
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|
(3 Do-more Designer - My_OM - (SMain] With the cursor in the position to the right of
File [Edt | Search View Tooks PLC Debug Window Help contact T1_Start, you are going to begin
4D Undo G2 £ - drawing a branch circuit. Under the Edit
¢ W D GG e
1) e feest || g bl] drop down menu, select Wire, then select
3 4 {a @ g3 | - Down. Notice the shortcuts that are available
L = it - & . . .
Rend B domoe/Sin | Dsta Debug Teend | St aisuws T wire drawing. The wire that should now
Projeq X Delete ol B0 g sain| appear in your ladder could have also been
I Thie tnsee- Ins drawn using the shortcut Cerl+Down Arrow.
B 1 Muge * T1_Start
B Select 3 C‘I l
P Contact.. ] # _; i l
Bp coi m NOTE: There are also Delete Wire options
d L :“:M i in the Edit drop down menu that are used
l—_-| g oML, . .
R iinictin P 2 to erase any wires not needed.
| #0 ToOutput CideW
E}“ Accept 8 Right Ctrl Right Arow
Edet Made Ctriet Left Crl« Left Ammow
1 E ’)‘f"ﬁiﬁﬁ_"_ B s— Up Chrl« Up Arrow
Ry S ol O
& System Info
82, Password Config (Defauki  DeleteRight  Curl«Shift- Right Arrow
1 — Deleteleft  CrrleShift=Left Amow
= Delete Up Ctrl+ Shifts Up Arrow
I '.:9@ ? '{ I‘ d  DuetcDewn Cuteshifts Down Arrow -|¢1- 'IEI'
Instructions .ﬁ.rn-pt 2 =] SheF? Th-FY = T <
| Draw wire connection down Run tem s 550 BB O} Dew

Now place the cursor in the space to the left of the new line and select another normally open

contact.
@i+ $Main Thx
11_5Stam rTuB ——— Timeg | —
r -
4 IClI Create Nickname M
[ ) T
Micknams: [T1_Marwial [ ok |
Assucisted Element, [C2 .
[ Zanrel
~ Cieale nicknane arl...
p—
[Eirliy —

" aszign o first uraised slement of specified type

Type in the nickname “T1_Manual” PMTDI“MEM .
and assign bit C2. Select OK to accept o I
and Rung #1 should now resemble the @ . a0gn 1o spectied element
rung seen on the following page. Elemenit. [C4 G
(1 |
 lpave unassignerd
I Tyoe [Bitf. v, C.etcl =]
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[
G+ $Main| b x
T1_Start e | |
c1
e
Timer Struct T1
Presel 3.0005
11 Mﬂl_“l;"
. L}
—'_
Rung #2

Place a normally open contact in the first position of Rung #2. This contact will be tied to the
Done bit of timer T1. Therefore, the name for this contact should be entered as “T'1.Done”.
There should be no Create Nickname dialog as seen with the earlier normally open contacts.

@i sMain | b x
T1_Start THR - — Timer j
C1
.
) .—’ i
Timer Struct ™
Prezat 20008
T1_Manual
jCZ
11 Done ,
2 = | { nop )

Lastly, you will need to add an Out coil to the end of Rung #2. Place the cursor at the end of
the rung and either select Out from the Ladder Palette Bar or just type “OUT” and select the
Out instruction from the drop down menu. Next, choose which bit will be tied to this coil.

Tie this coil to the physical output Y1 by typing “Y1” and click the checkmark.
The ladder program should now look like the following. When either the T1_Start or T1_

Manual contact is energized, the timer will begin timing. When it times out, contact T1_Done
will energize and the output coil Y1 will turn on. Note that an END instruction is not required.

@it SMain| 4bx
T1_Start THR - ~ Timer | —
C}I
t — }
Timer Struct ™
Praset 3.000s
T1_Manual
c2
T1.0Done ¥4
P 1 | ¥ y
2 =} o ar )
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The yellow bar in the margin signifies logic that has not been accepted. So once you have

verified your logic, click the Accept button in the Project Toolbar or the Ladder Palette Bar to

accept the changes.

(@t SMain| 4b %
/ Yellow Bar —
& 11 _star THR Tenerd |
C1
=
Timer Struct ™
Presel 3.000s
T1_Manual
.
T1.0one 3 :-7'{' o,
2 ; { our )
Fibe Edit Search View fuels PLC  Oebuy  Wadow Help
S T B 7 7 S 2
* e @ 2D s “ You should now see blue and green bars,
Open New  Backup Accept | Undo 1 . .
S & & | = shown below, signifying that the logic has
it wl My op R
b herme i beiwg T s wiaaw| 1O been downloaded to the CPU or saved.
rlefiEE] i) TH_Stat | g 5“5'"
1 4 Conmrol Logic €1
-G sMain | T1_Slart
B symtem Tasks c1
3 B Unused System Tasks 1 I 1
Tasks Becept )
B2 programs Button 1 Mansal
88 © : cz
[} <& Memary
| o Forces (Dusabiled)
a® Py T1 Dose 11_Manual
B Devices 2 CZ
Bl Unassiqned Micknames —]
- Toals
XY System Configurati 1
G systeminto T1.Done
B2, Password Conti (Defsult User - RD WD RP WP 55 PM 2 _J :
o [ Am 3 |
W @ b A U = 4 e 1=h
bteuctions Accept | B2 F3 | SheR2 SheRd | = | <

Now exit the Edit mode by once again clicking the Edit Mode button.
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Step 8: Save a Project

Save the project by selecting Save Project (Ctrl+S) from the File drop down menu. Or save
the file under a different name or in a different location by selecting the Save Project As...
option.

—— .
File | Edit Search View Tools PLC Debug Window
Mew Project » J

o
) Do-more Designer - My DM - [$Main]
- i

™ Open Project... Ctrl+0
£} Close Project

el

g SaveProject As... more/Sim | Data  De
g Read Project from PLC  Ctrl+F9 Qx|
i@l Write Project to PLC Shift+F9

Step 9: Write Project to the Do-more PLC

Now that you have created the example ladder logic program, you can write the program to
the PLC. To do so, click the Write PLC button in the Project Toolbar.

- Do-mare Designer - My, DM - (3] =R
Fle  Ede Seach View Took PLC Debug Window Help

2 ¥ & o D ¥ & B8R 2Rt lwE @ 1

| Open Mew  Backip | EddMode Unde Find Browse | Prevesws  Med  Ouigd Ophions | On The Web

£ 7 —“— o - o x B —
@R e owmow @D oy &
ResdPLC Wite PLC_Mew Onlioe Do-moeeSen | Dits  Debug Trend  Sttu AllStatu NofStatsr | Forces  Vahue Info  Configure Devicts Check | PID Ovenview =
Pacyeet Browaes 31 | @i Shkain| 1 b %

ra]i3| =] shlss j
B} Contrel Lagi TH_Stet 715 =
';}Q'Tni:l:n Y = it
B system Tacks Write Project to 1 fed }
5 B8 unused Smtem Toskes PLC Troer swz:
B Taske Fria ke
55 Peograms
=% Configuration T4 _Mznual
1 Memary _Jcrz
v Forges (Dissbled)
g =1}
= Deaces T1Dens o
£2% Unassigned Micknames v b=} | o _1}
12 Took

XY System Configuration

-

€ systemints F]
B8, Pasgeord Crnbeg (Diclault User - RD WO RP W 55 PM
3| |
LE I AL | = 42 e s e 42 A s @ | 2
Broase Edit Mode .
Rum rom s | 5 B D DeaOK | PLEOK | Gni 1 S HIOMI  SMain=288:00T
- S =

- e - =

-
L=

Far Helg, press Fl

If the Write PLC button is not active, then you must first connect to the PLC to activate the
online portion of the Project Toolbar (see the “Establish Communication” section of this
chapter). If you have altered the System Configuration, which includes the hardware
configuration, in any way, then the PLC must be taken out of the Run mode in order to
process the download.
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r.i\Hzenhonl w‘
The n?essa.ge. seen here.Wdl appear ask{ng yOl.l FO Diowrinad of Modiied System Configuration aperation onl works when
verify if this is a good time to do so. Since this is Ui EXE I PH O st e VG ELL e 2o n BUN tiode.

the setup phase of this system, select Switch to
Program Mode and continue with the download.

Iz ok i switch friom RLIN mode i PROGRAM mode?

Cancel Switch tn PROGRAKM Mode I

If this system was previously commissioned
and in use, then you would need to verify that
the process it is controlling can be interrupted at this time (57 5 jou =)
before continuing.

L — — ]

| Current PLC Status

Download the project and once the download is finished, PLC Mode:  PROGRAM
assuming there are no errors, the Do-more PLC should S Hine

return to the Run mode. If at any time you | | SwitchPosior: " '
need to change the PLC mode, select the Mode ﬁ Mo PLE Mok

icon in the Project Toolbar, click the Mode Mode | i

Status indication in the Status Bar or select  Fronan
PLC > PLC Modes....
In oader bo change modes from Do-more 1]

The PLC Modes window shown here will open displaying || Desure. the PLC Muds Swtut st b
M . . S the: Teminal position.
the current mode the PLC is in with options to change it

to either Run or Program mode. Click OK to accept the || L— | _comed | ek

change or Cancel to exit. - 4

Step 10: Testing Project Using Data View

With the project successfully downloaded into the Do-more PLC, you can now test
the function of the ladder program using the Data View tool. To start, you need W‘{‘]
to open a new Data window in the software. To do so, click the Data icon in the
Project Toolbar, select Debug > Data View > New or press Ctrl+Shift+F3.

Da-ta

B 3 00 The Data View wir.ldow seen.here will now open. This
Elament T Stats T|| window will open in the project browser section of the

! programming window but it can be relocated anywhere
3] on the screen by clicking the title bar and dragging it to

3]

% a new location.

= Now enter the elements that you wish to monitor. On
B line one type “C1” under the Element column and press
9

Enter. You will see the C1 change to the variable name
B . associated with it or T1_Start. On line two type the
Fon Help, press FL element “C2” and on line three type “Y1”.

With the ladder elements entered into the Data View window, you now need to activate their
status. To do so, click the All Status icon on the Project Toolbar or select Debug > All Status
On. The All Status On option will not only activate the status of the Data View window but
also the status of the ladder program as seen on the following page.
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The next step is to enable edits within the Data View window. To do so, click the yellow box
with the “E” found in the top left corner of the Data View window, as seen above. The Edits
column is now added to the Data View window.

The Edits column allows you to make changes to the current values of the elements listed.
T1_Start’s current value is OFF. Click the ON button under the Edits column and the Write
Current Edit and the Writes All Edits buttons will appear at the top of the window. These
buttons will write individual or all edits made in the Data View window to the PLC.

> oo s 55

[Fie Edt Seach Wiew Tools PAC Debug  Windiw  Help
R R d - LA L L RN I = i
Open Pew  Backup Unda Find. ' Brewse | Pressss  Met  Output Options  On The Weh =
o . ) _-* = = s . I "
& & e ¢ 1w T E oww Y oy @ =
Mew Online Do-mceeen | Osta Oebug  Teend AllSigbus MoStsbes  Fosces  Value | Mode  Info  Corbigue Dovces  Check | P Overew
Progect Beomser x| gt Satain| abx
kI Wirite Write All E’l
E={ } Control Lagic Curmrent Edit Edits Timat
e Gt i
Eiw-.m Dutal N ol W il
;B unused A———F
&HI:.A. [ [e | |g‘[ﬁ.& S
2 vrograms Elemant Satus Bone
¥ confiquration | 7] T1_Saan G g Timing
B3-S Memary 170 T1_Masnaal L
¥ Forcm i 75 ] il =
. oy 1]
il o Devices 0
i Unsmigned O
= 2 Took 71
KY Systemn Cos 0
B, Password & 3 l_’:u-'" ) l
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% 5 ) { woe )
P @ AL N s e s R A ) S R 2w
Instruetioms £ B | BB A | . ] < s Deta | Out St Reset | Browse | tw =
For Help, press FL seTarmuse | & B 0 BesOF | PLEOK n.dwnd.unu«rmuj-nmmsm DML A

Click the Write Current Edit to PLC button and confirm it. This will write the new value to
T1_Start. Once T1_Start changes to an ON state, the timer (T'1) will begin to time and
quickly reach the preset. As soon as the preset is reached, the done bit T1.Done, will turn
ON causing output Y1 to also turn ON as seen on the following page. Now write an OFF to
T1_Start and watch as the timer and Y1 reset.

1—30 I Do-more H2 Series PLC Hardware User Manual, 1st Edition, Rev. J - H2-DM-M


http://www.automationdirect.com/pn/H2-DM-M

Chapter 1: Getting Started

I Domor Desgrer- O - (intun]_ iy e D = S B e S W e e e
File Ecdt  Seach Voew Tooh PIC Debug  Window Help -8 X
PQEe DK BR(®B LN [E “
Open Mew  Bachup Unda Find t Browse t Optionz | On The Web =
| '.I'.'— - a" J-‘. . - e . " = B
| @ @ i@ = Lo Aoy & =
New Onlime  Do-more/Sim. Data Debug  Trend Al Status Mo Satus | Forces  Value Mode Infe  Configuee Deices Check | PID Overdew -
Pregoct Botrarier Bxl| @0 swin|
rlwE salay
[| = =L} Comrel Logee Ti_start
I '“EE"" L)
Sysbem Taskes ==
4 u_!LInm.:iy\lmTﬂ\ i b
| | Dol
17 |® o =1 (O] ] ]
Elomant Stal Edits -
r|°_$lm ] = o o] T1_Nariml
T1_Manual Lid ) ew
v W —
" i
—l = e T S
. i
Al R A RO S AR © |
Instructions. 7] 17} SheFl SheF3 = ] “ = Deha Out et Pt Broaye A -
Fuor Helg, press F1 TN B 08 PLEOK mm.mumm_mumﬂs;ﬁ HE- Dk

Congratulations, you have now programmed, downloaded and tested a ladder logic program for
the Do-more PLC. Feel free to experiment with a program of your own and don’t forget that
the software Help file is an essential tool to use when programming your controller.

Accessing the Help File

The Do-more! Designer software Help file, seen below, isavailable asa quick reference or
detailed guide to the many features and capabilities of the Do-more PLC. To access the

Help File select the Help File icon from the Project Toolbar, choose Help from
the Help menu drop down or use the shortcut F1.
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Debugging Do.more Projects

tayction Stys
The Status Bar

Jzing the Trand View ko hionitor tha MX

Cantreller

Uzing the Diata View to Maedor M Comraller
Momans

Do-more H2 Series PLC Hardware User Manual, 1st Edition, Rev. J - H2-DM-M I 1 _3 1


http://www.automationdirect.com/pn/H2-DM-M

	Introduction
	Purpose of this Manual
	Purpose of this Chapter
	Online Help Files and Other Documentation
	Technical Support

	Conventions Used
	Key Topics for Each Chapter

	Before You Begin
	Do-more! PLC System Components
	Do-more! Designer Software System Requirements

	Step 1: Install Do-more Designer Software
	Step 2: Launch Do-more! Designer Software
	Step 3: Install Hardware
	Step 4: Apply Power to the Do-more! PLC
	Step 5: Establish Communication
	Step 6: Verify Hardware Configuration
	Step 7: Create a Ladder Logic Program
	Rung #1
	Rung #2

	Step 8: Save a Project
	Step 9: Write Project to the Do-more PLC
	Step 10: Testing Project Using Data View
	Accessing the Help File

